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WARNING:
The AMX-DESK software and Manual for the BBC Computer is published by
Advanced Memory Systems Limited (AMS), AMS and Elliot Software Limited can
accept no responsibility for errors and/ommissions in the software and/manual
and cannot be held responsible for consequential damages arising out of any
errors or ommissions on their part.

AMX-DESK is specially created for owners of the AMX Mouse package and is only
useable on disc-based systems. The AMX Mouse and AMX ROM must be installed in
the computer when running AMX-DESK. Two versions of the AMX-DESK program are
supplied, a standard BBC version on side 0, and an 80 track 6502 second processor
version on side 2. The second processor version has the advantage of greater speed
and the Calculator overlay facility is available at all times.
The AMX-DESK disc is recorded in 40 TRACK format, and 40 track disc users should
back up their disc to a newly formatted disc by use of the DFS "* BACKUP"
command. Users of 80 track disc drives must copy their disc to a formatted 80-track
disc by CHAINing a special conversion program on the disc (see 2. below).
The programs contained on the disc include the AMX-DESK suite, which allows a
"desktop" environment to be created on your standard BBC computer in the manner
of larger business computers. Facilities are made available to catalogue discs in
standard or Icon format, load and run BASIC and machine code programs simply by
use of the Mouse buttons, use an on-screen calculator, refer to a desk diary, consult a
telephone & address book, and write and print out simple memos. Most features are
available instantly from pull-down menus or easily identified Icons, and the user may
move between the various programs with ease. Printing out of information on an
EPSON compatible printer is done by simply pointing at the "printer" icon.
Also contained on the disc are two programs to enable users of the Acornsoft VIEW
and the Computer Concepts WORDWISE plus wordprocessor ROMS to create
picture files on disc allowing AMX-ART pictures to be merged with text and printed out
on an Epson compatible printer in a single pass (see 7. later).

1. THE AMX-DESK DISC
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NOTE: The disc should be backed up onto a new formatted disc.
Users of 80 track disc drives must first copy their disc onto a previously formatted 80
track disc by using the special conversion program on the disc. Simply insert the AMX-
DESK disc into your 80 track drive and type 'CHAIN "80" < RETURN > ' and the
program will give instructions for the copying process to 80 track format. The
instructions for use are now as for 40 track drives, but additional file space will be
available for the Desk Diary and Telephone/Address book features.

Before using the AMX-DESK for the first time on your BBC computer, the SETUP
program (see 2.1.2 belON) must be used to create a file on disc which contains
essential information about your system, Le. number of disc drives available, in which
drive the AMX-DESK data disc is normally used, whether your printer is set up for
automatic line feed, if interlace is required on your display, and if the picture requires
to be moved up or down a line on your display.

On first running the program there will be available on the System Disc approximately
16K of file space for use by the Diary and Telephone/Address Book facilities. This will
allow for only 16 Diary/Telephone Book entries combined, and allow initial use of the
disc whilst learning the system. To create more file space, a new Data File must be
created, and a special 'GEN' program is included on the disc for this purpose. This
program is run by typing 'CHAIN "GEN" < RETURN > " and selecting option 1.
'Generate New File'. By following the prompts you will be able to generate a file for a
total of up to 1300 records to be used in the Diary and Telephone/Address Book
facilities. The size of file will vary according to the capacity of the disc available as
follows:
40 Track 100K Single Sided Single Drive
In this case you will be able to create a new file on a blank disc of 600 records. This
allows you to store 600 names/addresses and Diary entries, and also leaves 10K free
on the disc for Memos. Set up the disc using the 'Set Up' program included to use
drive 'x'. The AMX Desk programs will then instruct you to swap discs over when
required.

2. USING AMX-DESK

2.1 CONFIGURING THE AMX-DESK DISC

2.1.1 CREATING A NEW DATA FILE
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80 Track 200K Single Sided Single Drive
A file of 1300 records can be created as above although disc swapping will still be
necessary. However since there is 100K extra space on the System Disc it is possible
to create a 600 record file on the System Disc, and this may be sufficient for your
needs. The Set up program should then be used to allow drive 0 to be used for data.
40/80 Track Double Sided
Create a new file on the second side (drive 2) of 600 records (1300 for 80 Track drives).
Then set up the disc (Using the 'Set Up' program) to use Drive 2 as the data disc.
40/80 Dual Discs
Create a new file on Drive 1 of 600 records (1300 for 80 Track) and set up the disc to
use Drive 1 as the data disc.
With a full 200K data file on an 80 track disc it is possible to store a diary entry for each
day of the year, and 24 entries under each letter in the Telephone/Address book.

Insert the disc into drive 0 and type 'CHAIN "SETUP" < RETURN > " and you will be
presented with the Set Up Screen as shown in figure 1.
In the top 'Disc Drives' window, the drive numbers available are indicated by inverted
characters, and discs not available may be indicated by moving the pointer over the
drive number and pressing the EXECUTE button. Similarly the drive number to be
used for the Data disc may be specified, 80 track users will be able to store up to 100K
of data on the AMX-DESK disc itself in drive 0, but single 40 track disc drive users will
have to swap discs to read in or store data on a separate data disc. This is signified by
the 'x' option.
In the second Auto Line Feed' window you may specify whether your printer is set up
for automatic line feed on carriage return.
In the third 'TV' window, Interlace may be switched on or off, and the picture may be
moved up or down one line by pointing at the up or down arrow and pressing the
EXECUTE button. When you are satisfied that the information is correct simply point
at the 'complete' button and press EXECUTE.
The program will then create a file on the AMX-DESK disc containing the required
information about your system, and the program will now be matched to your system.
Should you wish to re-configure the program for a different system the above process
may be repeated at any time.

2.1.2 THE SET UP PROGRAM
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For users of 40 TRACK disc drives, (and 80 track drives following conversion as in 2
above), insertthe disc in drive 0, holding down the < SHIFT > key and press < BREAK
>. You will now be presented with the initial screen as shown in figure 2. You are
prompted to input the date and time, and this will be maintained in the computer
unless it is switched off at any time.
The date is typed in the "day:month:year" format with colons separating the figures,
e.g. "01:12:1985", or "1:12:1985" followed by < RETURN >. Leading zeros are not
necessary. The time is similarly typed in "hours:minutes:seconds" format with colons
separating the figures, e.g. "21 :05:30", or "9:5 P" (seconds are optional), and, times
after midday may be inserted in either 24 hour mode, or using "P" to denote p.m. On
pressing < RETURN >, the Desk Top screen will now be displayed.

2.2 RUNNING AMX-DESK

Fig. 1: The SET UP Screen
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Fig. 2: The Initial Screen
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The Desk Top screen contains icons for the number of disc drives available and the
various accessories down the right hand side. The current time is indicated at the top
right of the screen header and this may be removed and replaced by pointing and
pressing EXECUTE over the "clock" icon. Pointing at the Drive 0 icon and pressing
EXECUTE will catalogue the disc in icon form as in figure 3. Where possible the AMX
DESK program will allocate an appropriate icon to each file, and more detailed
information on the files may be obtained by pointing at the required icon, pressing the
EXECUTE button which will invert the title of the file, and then selecting "show info"
from the VIEW pull-down menu at the head of the screen. Pressing EXECUTE twice
over a file name will cause the program to attempt to open and run the file, an error
message will be displayed if the file cannot be opened. For instructions on the use of
pull-down menus see 3.2 below.

Other icons present on screen are a 'calendar' icon which enables the Desk Diary to
be opened by simply pointing and pressing EXECUTE, a sheet of 'paper'
representing the Memo Pad which is similarly available, a 'telephone' icon which
allows access to the Telephone/Address Book, a 'Printer' icon which allows printing
out of

2. THE AMX-DESK TOP

Fig. 3: The DESK TOP
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the contents of the window in the Desk Diary, Memo Pad, and Telephone/Address
Book on an Epson compatible printer. The 'waste bin' icon is used in the Telephone/
Address Book for the deletion of entries as an alternative to the pull-down menu
facility.

Where a system file has been saved under the "S." prefix, a '?' icon will be displayed.
This will prevent unintentional attempts to RUN the file, but if tried this will result in a
'Can't open' prompt.

Where Fill patterns have been created using the AMX-ART UTILITIES Patterns
program, and saved with the prefix "F", as suggested, a "paint pot" icon will be shown,
and on selecting "Show info" from the VIEW pull-down menu these will be identified
as "Patterns".

Where Icon files have been created with the AMX-ART DESIGN program, and saved
with the prefix "I." as suggested, a "paint pot" icon will be shown, and on selecting
'Show info' from the VIEW pull-down menu, these files will be shown as "Icons".

Where AMX-ART pictures have been saved with the prefix "P" as suggested, a "paint
pot" icon will be shown, and they will be identified as "Picture" in the 'Show info'
option.

Memo files created by the AMX-DESK program are automatically saved with a prefix
"M.", and an "envelope" icon will be shown, and they will be identified as "Memo" in
the 'Show info' option.

3.1 FILE TYPES

3.1.1 SYSTEM FILES

3.1.2 FILL PATTERNS

3.1.3 ICON FILES

3.1.4 PICTURE FILES

3.1.5 MEMO PAD FILES
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Where the execution address of a file is either &801 F, &8023, or &B023, the program
will recognise the file as a BASIC program and a "folder" icon will be shown. The file
will be identified as 'BASIC' in the 'Show info' option.

Where files have a load address of &0000 they are recognised by the program as Text
files, and an "a" icon will be shown. The file will be identified as "Text" in the 'Show
info' option. WORDWISE text files are saved with a load address of &0000 are are
therefore recognised, but VIEW text files are not recognised, and are displayed as
machine code files with a "disc" icon.

Where files are unrecognised by the program, a "disc" icon is shown and the files are
identified as "Machine code" in the 'Show info' option.
NOTE: Care should be used when attempting to RUN files identified as Machine Code
files, only programs with a valid execution address should be run, others may cause
the program to crash! Should this happen, re-boot AMX-DESK by holding down
< SHIFT > and pressing < BREAK >. You will find that the system parameters, time
etc. will have been preserved.

At the head of the screen are the headings for the standard pull-down menus,
MOUSE, FILE, and EDIT, and these menus are available at all times when AMX-DESK
is in use. The standard menus are designed to be used in all suitable programs, and
may contain options which are not available in certain programs.
In order to speed up the selection process, the menu selection procedure has been
altered to that on the AMX-ART program, and is now identical to that used on the AMX-
UTILlTIES disc. To reveal a pull-down menu, move the pointer over your required menu
heading, press and HOLD DOWN the EXECUTE button. The menu will now be
revealed, with the available options in black, the current option being indicated by a
tick. Any options not available for any reason at that time are shown in grey.
Selection of the appropriate option is made by HOLDING DOWN the EXECUTE
Dutton and moving the inverted bar over the required option. RELEASING the
EXECUTE button will now select your required option.

3.1.6 BASIC PROGRAMS

3.1.7 TEXT FILES

3.1.8 MACHINE CODE FILES

3.2 THE PULL-DOWN MENUS
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The first pull down menu is indicated by a Mouse icon, and when selected as
described above, reveals the options shown in figure 4.

HELP merely indicates the Version number of your program, and you will be
requested to press EXECUTE on the Confirm 'button'.
CALCULATOR when selected overlays the current screen with a nine digit-four
function calculator with percentage key and memory function. On the standard BBC
computer, the calculator may overlay the Desk Top screen and the Telephone/Address
Book screen only, and at other times is used by selecting QUIT from the FILE menu
first. In the second processor version the calculator may also overlay the Desk Diary
and Memo screens.
The calculator is operated by means of the Mouse pointer and EXECUTE key, in a
manner similar to a normal pocket calculator. Results of calculations are displayed in
normal mode unless they overflow the display when they are converted into scientific
mode. Results of calculations may be stored in memory by means of the "M" 'button',
and recalled by means of the "R" 'button'. The "C" 'button' clears the calculator of
all figures. A result shown in the display may be saved on a clipboard file on the
System

3.2.1 THE MOUSE MENU

Fig. 4: The Mouse Menu
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disc by pointing at the display window and pressing EXECUTE. This may then be
later 'pasted' into a Memo or into a Diary entry (see later). The Percentage key when
used in calculations takes the percentage of the previous displayed result, e.g.:

78.22 + 15 % = 89.95(3) 78.22 - 20 % = 62.57(6)

SYSTEM, when selected displays a prompt window which enables users to enter
*Commands whilst in the AMX-DESK program. This allows for the entry of Printer
ignore character (*FX 6,0), alteration of repeat speed, Deletion and Renaming of
Files, etc.
NOTE: Extreme caution must be observed when carrying out file operations with *
commands. When files are deleted or renamed in this manner, the disc must be re
catalogued by pointing at the appropriate drive icon before the screen display is
updated.

3.2.2 THE FILE MENU

Fig. 5: The File Menu
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The second pull down menu is indicated by FILE, and when selected reveals the
options shown in figure 5.
OPEN allows access to a file on disc, and when entering the file name this should be
preceded by the appropriate drive number, e.g. ":3.Message". Selecting OPEN has
the same effect as pressing EXECUTE twice over a file in the Desk Top Catalogue.
NEW is only available from the MEMO program, and has the effect of creating a new
memo file on disc. The file name should be preceded by the appropriate drive number
if this is not drive O.
SAVE is not available in this version of AMX-DESK.
CLOSE is only available in the MEMO program, and has the effect of saving the
current memo to disc.
QUIT is available at all times, and is used to return to the Desk Top in order to use
another facility such as Calculator or Catalogue. When selected from memo Quit will
automatically close the memo file before returning to the Desk Top. Another way of
moving to another facility is to point and EXECUTE over the appropriate icon, but to
avoid the loss of text you will be prompted and given the opportunity to save the text
first.

The third pull down menu is indicated by EDIT, and when selected reveals the options
as shown in figure 6.
CLEAR is used for clearing selected areas of text in the Memo facility, and deleting a
day's entry in the Diary facility.
CUT is available only in the Memo facility, and is used to REMOVE a selected area
of text and place it on the clipboard file for 'Pasting' into another part of the memo, or
even into a Diary entry where appropriate.
COPY is used in the Memo, Diary and Telephone and Address Book facilities to COPY
a selected area of text or an entry onto the clipboard leaving the original intact.
PASTE is used in the Memo and Diary facilities to copy text from the clipboard file to
the cursor position.

3.2.3 THE EDIT MENU
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In the Desk Top, Memo, and Telephone/Address Book facilities, there is an extra pull
down menu which gives additional facilities which vary according to the program being
used.
(i) On the Desk Top screen, the additional menu is titled "View", and contains

options to alter the manner in which the discs are catalogued and to give details
of program type and length (see figure 3). Selecting "By Icon" will enable
cataloging by icons as described in section 3 above. Selecting "By name" will
catalogue the disc in the normal manner: Having highlighted 'the file by pointing
at the name and pressing EXECUTE, more information on the file may be
obtained by selecting "Show info" from the VIEW menu. This will reveal a
window giving File name, File type, Length in bytes, and a Confirm 'button'.
Selecting Confirm will remove the window.

3.2.4 SPECIAL MENUS

Fig. 6: The Edit Menu
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(ii) On the Memo Pad screen, the additional menu is titled "Options", and contains
options to justify and centre text, Split line, and Delete lines, (see figure 7), and
the use of these facilities is described in section 5 below.

(iii) On the Telephone/Address Book screen, the additional menu is titled "Options",
and contains options to Insert and Delete entries, and an option which is not
available in this version of AMX-DESK "Dial number". The use of these facilities
is described in Section 6 below.

Fig. 7: The Options Menu
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The Desk Diary facility is accessed by pointing at the 'calendar' icon and pressing
EXECUTE. The icon will be inverted, and the calendar window will be displayed as in
figure 8. The window displays the current month and the following two months in
calendar form. Dates with entries are inverted. The months may be scrolled backwards
and forwards by selecting the up/down arrow icons at the base of the window.
Calendars are generated for 1985 and 1986 initially, but the range of the calendar may
be amended by running the program "Gen" from the Desk Top, and selecting option 2
"Create New Year". This program adds an extra year to the calendar, deleting the initial
year from the disk.

Selecting a date from the calendar will generate a window containing four days
commencing on the date selected as in figure 9. The window may be scrolled
backwards or forwards through the days by means of the up/down arrow icons at the
base of the window. On the top line of each day's entry is a space for an optional
'alarm' time which is entered by moving the cursor to the start of the space using the
MOVE button and typing in the required time separated by colons followed by
< RETURN >. "P' may be used instead of 24 hour time notation as in the Initial Screen.

4. THE DESK DIARY

Fig. 8: The Calendar Window
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Once the time is set, the alarm will become effective when you scroll or exit the
calendar and will sound a "beep" and place an asterix at the head of the screen
adjacent to the current time. This alarm facility is of course only effective if you are in
the AMX DESK package when the alarm is due.

For each day in the diary there are four lines available for text, and the diary entries can
be changed at any time. To insert an entry, simply move the text cursor to the start
position using the MOVE button, and type in the text. Entries may be Cleared, Copied
to the clipboard file, and Pasted from the clipboard file using the EDIT pull down
menu.
Selecting 'Clear' will produce a confirmation window and selecting 'Confirm' will
delete the day's entry at the current text cursor position. Selecting 'Copy' will put the
day's entry onto the clipboard for 'pasting' into another part of the Diary or
incorporating into a Memo. Similarly, text on the clipboard file may be copied into the
Diary using the 'Paste' option, any surplus text being ignored.
Either theCalendar window or the Diary window may be printed out by simply pointing
at the Printer icon and pressing EXECUTE.

Fig. 9: The Desk Diary
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The Memo Pad facility is accessed by pointing at the 'memo' icon and pressing
EXECUTE. The icon will be inverted and the desk top will be cleared to allow a memo
to be written. Move to the FILE menu and select 'Open' or 'New'. OPEN is used to
load a previously written memo, and is useful for standard memo formats. Simply type
in the name of the memo preceded by the drive number where appropriate, and the
first page of the memo will be displayed as in figure 10. Text may be typed into the
memo by first positioning the text cursor using the MOVE button. A second and third
page of memo space is available by pointing at the up/down arrow icons at the base
of the page.

When complete, the memo is printed by simply pointing at the 'printer' icon and
pressing EXECUTE. Each page of the memo is printed separately in this way. In order
to preserve the standard memo format, i.e. without the added text, the 'Undo' option
may be selected from the EDIT menu, and this clears the memo to the original form
as stored on disc and allows another memo to be written in the same format.

5. THE MEMO PAD

Fig. 10: The Memo Pad
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NOTE: If you QUIT from memo without undoing the additions the original version
will be automatically replaced by the amended version. Another way of leaving Memo
Pad without saving the amended version is to simply select the Desk Diary or
TelephonelAddress Book icons, which will run the programs direct. Your text will
however be lost if you return to the Memo Pad.
New memos are created by selecting NEW from the FILE menu and typing in the
name of the memo when prompted. This may be preceded by the drive number where
appropriate, Le. Memos may be stored on a separate memo disc in another drive.

There are a few simple editing facilities available in Memo Pad, which are not intended
to make it a full-blown word processor, but are nevertheless useful. Many of the
options are only available after selecting the area of text you wish to operate on. This
is done by moving the text cursor to the start of the required area using the EXECUTE
button and HOLDING DOWN the EXECUTE button as you move the Mouse. This
will invert an area of text to identify the section affected by the editing operation. The
area selected may be altered at any time by repeating the process. The CANCEL
button may be used to cancel the area selected.

In the EDIT menu Clear, Cut, Copy, Paste, and Undo are available, depending on
whether an area of text has been selected as shown in figure 11.
CLEAR is used to clear a selected area of text to allow amendments to be made. CUT
is used to remove a selected area of text and place it on the clipboard file for 'pasting'
into another part of the memo, or even into a Diary entry where appropriate.
COPY is used to copy a selected area of text onto the clipboard leaving the original
intact, for copying into another memo or into a Diary entry.
PASTE is used to copy text from the clipboard file to the current cursor position, and
adequate space must be available on the page as any overflow will simply wrap
around on the last line available.
UNDO is used to remove any changes you have made to the original memo in order
to type a new memo on the same format, and must be used to preserve a standard
memo if using QUIT or CLOSE in the FILE menu.

5.1 EDITING FACILITIES

5.1.1 THE EDIT MENU



18 AMX-DESK GUIDE

In the Memo Pad, a special Options menu is available, and includes options for Justify,
Centre, Split Line, and Delete Line as shown in figure 12.
JUSTIFY is available only when an area of text is selected as above, and when used,
any complete lines selected are right justified by the judicious addition of spaces
between words. Any part lines in the area selected will not be affected by the process.
CENTRE is available only when an area of text is selected as above, and when used,
any complete lines selected are centred by equalising the spaces available at the start
and end of the lines. Any part lines selected will not be affected.
SPLIT LINE is available at all times and when used will insert 32 character spaces
commencing from the current text cursor position.

5.1.2 THE OPENING MENU

Fig. 11: The Edit Menu
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DELETE LINE is available at all times, and will remove 32 characters commencing
from the current text cursor position in a forward direction.

Fig. 12: The Options Menu
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The Telephone/Address Book facility is selected by pointing at the 'telephone' icon,
and pressing EXECUTE. The icon will be inverted, and if leaving the Memo Pad, you
will be given the option of saving your text. The Front Page of the Telephone/Address
Book is displayed with an alphabetical index of entries as shown in figure 13.

Pointing and pressing EXECUTE over the initial letter required will reveal a list of
entries, and pointing and pressing EXECUTE over the entry will expand the entry as
shown in figure 14. You may examine entries above or below the selected entry by
selecting the up/down arrow icons at the base of the screen, and in this way multiple
entries may be created giving further information.
For reasons of clarity, a clear line is automatically generated between the name line
and the first address line, and between the fourth address line and the telephone
number line. To insert an entry into the 'book' at any time, select 'INSERT' from the
OPTIONS menu and a blank entry page will be displayed. Type in the required entry,
commencing with the Surname and pressing < RETURN > at the end of each line.

6. THE TELEPHONE/ADDRESS BOOK

Fig. 13: The Telephone/Address Book
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On completion of the last line of the entry, the details will be automatically filed on disc
in the correct alphabetical order. If more than one entry is required with the same first
line, a slight change must be made as the program checks to prevent overwriting
previous entries. This is easily achieved by adding "a", "b", etc. to the end of the name.
Entries may be deleted at any time by first selecting the entry and then selecting
'DELETE' from the OPTIONS menu or simply pointing to the 'waste bin' icon and
pressing EXECUTE. You will be prompted to confirm the instruction before the entry
is deleted.

Pointing at the "Printer" icon and pressing EXECUTE will allow for the printing out of
each page of the telephone list, and when executed on an entry, the entry will be
printed out.

Fig. 14: The Telephone Entry
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For serious word processing applications it is recommended that a more advanced
wordprocessor such as View and Wordwise Plus is used. Details of using the Mouse
in these programs is given in Appendix A. Also included are programs which allow
AMX ART Pictures to be merged with your text so that text and illustrations are printed
out in a single pass of the printer, obviating the use of scissors and paste!
Two distinct steps are required to insert a picture into text. First the picture must be
converted into a SPOOLed file on disc. This file contains all the printer codes
normally sent to the printer when a picture is printed. The Program which does this
conversion is called 'CONVERT', and can be run directly from the Desk Top screen
using the Mouse. When run, CONVERT will prompt for the name and Drive number
of the picture to be used, and the Filename (including the Drive number) it is to be
stored under.
The second process is to add commands to your word processor which allow for the
creation of a 'Print Picture' command, and makes allowance for the space required in
the text. The programs, printer drivers, and macro files may be transferred from the
System Disc onto your wordprocessing work disc on single disc drive systems by the
usual DFS command (*COPY). There are two versions of this software for VIEW and
WORDWISE PLUS.

The second process is to use a special EPSON printer driver and a Macro File which
should be loaded in before you commence to write the document. Type 'LOAD
S.Macros < RETURN >' and a macro 'FG' is loaded at the top of the text space. The
printer driver must be loaded before printing out the document by typing 'PRINTER
S.EPSON < RETURN >'. The printer driver includes the Normal, BOLD, and
Underline features, and pictures are inserted into the text by including the macro
command FG at the start of a clear, line followed immediately by the filename of the
spooled file. On the following line, the edit command CE is followed by the picture title,
e.g.:

FG :1.Desktop
CE Fig. 15: An ExampLe of a Merged Picture

When the text is previewed before printing using the 'SCREEN' command, a
rectangular box will be displayed allowing the position of the picture on the page to be
seen. Adjustments to paging and/or the position of the 'FG' macro may then be made
if required before printing.
Obviously, when printing commences the disc containing the SPOOLed picture file
must be present, so that on single drive systems, the disc containing the spooled
pictures must be inserted in the drive before printing commences.

7. USING PICTURES IN DOCUMENTS

7.1 USING PICTURES IN VIEW
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To initialise the process, two 'SEGments' must be loaded from the Wordwise Plus
SEGMENT Menu, these are called 'S.SegO', and 'S.Seg1'.
Whenever you wish to use a picture in your text press < SHIFT> + < Function key
0> which executes the program in Segment O. The filename of the SPOOLed file is
then typed immediately after '*/S.WORD+ ’. If a picture title is required, it is put on the
line below, including a CEntre command if required.

7.2 USING PICTURES IN WORDWISE PLUS

Fig. 15: An Example of a Merged Picture
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To enable the Mouse to be used in View and Wordwise Plus it must be first enabled
using *MOUSE ON and < BREAK >. To use the Mouse to move the cursor use
*MCURSOR ON and *SENSITIVITY 3. Then by moving the Mouse the cursor will
also move around the screen..
To allow the use of the Mouse buttons the *BUTTONS n command should be used.
With n equal to 7 the keys generate < shift > + < cursor > keys - right, up and down
(for the Left, Middle and right buttons respectively) and are therefore useful for scrolling
around the screen quickly. The most powerful use however is when the buttons
generate control-shift Function Keys in View and Shift Function keys in Wordwise Plus,
e.g.

*MCURSOR ON Use Mouse as cursor keys
*SENSITIVITY 3 Set Mouse Sensitivity
IN VIEW:
= > *BUTTONS 4 Use as Control Shift Function Keys
= > *FX 228,1
= > *KEY 2 I I £1 Left = Set marker One
= > *KEY 1 I I £2 Middle = Set marker Two
= > *KEY 0 I I I \ Move Block

In Wordwise Plus *BUTTONS 2 should be used then the SEGments 0,1 and 2 will be
executed whenever the Right, Middle and Left buttons respectively are pressed. Then
by suitably programming the SEGments the required functions can be provided.

APPENDIX A
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